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Dear customer,
thank you for having decided for a BYK-Gardner 
product. BYK-Gardner is committed to providing 
you with quality products and services. We offer 
complete system solutions to solve your problems 
in areas of color, appearance and physical 
properties. As the basis of our worldwide business, 
we strongly believe in total customer satisfaction. 
Therefore, in addition to our products, we offer 
many VALUE-ADDED services: 
-	 Technical Sales Force
-	 Technical & Application Support
-	 Application and Technical Seminars
-	 Repair & Certification Service 
 
BYK-Gardner is part of the Additives and 
Instrument Division of ALTANA AG, a leading 
supplier of additives for coatings and plastics. 
Together, we offer complete and unique solutions 
for you, our customer.

Thank you for your trust and confidence. If there is 
anything we can do better to serve your needs, do 
not hesitate to let us know.

Your BYK-Gardner Team
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1	 Menus

1.1	 Menu Data 

The Data Tab contains commands for editing data 
files or measurements. temp-gard-measurements 
are saved in database. They do not only contain 
the data values of the connected sensors (the 
temperature curves) but also parameters descri-
bing the measurement setup. Therefore, the terms 
File and Measurement here mean the same thing. 
Please also refer to the chapter How to Work with 
QC Procedures  as it contains useful advice for an 
easy operation of the program.

1.1.1	 Section Measurement 

The section Measurement contains the following 
com​mands:

Import 	
Allows to import a measurement saved in a single 
file into the current database. These files (*.txt) 
may be generated by the export command (see 
below) or by a previous version of the temp-chart 
software (*.btr).
Additionally it ispossible to import CSV files. If you 
have questions to this item, please contact our 
application specialists.

Menu Data
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Menu Data

Export
Saves the currently active measurement into 
a single file that may for example be sent via 
e-mail and then be imported again into a different 
database (save as *.txt). You may also choose to 
export the raw data into an Excel sheet (save as 
*.xls).

Merge

In this menu option measurements of different 
files can be merged. A selection window opens, 
in which the available measurements are listed 
on the left side. Both a complete data record, and 
individual sensors can be selected. By clicking the 
measurement and a following click on „add“, the 
measurement appears in the selection list on the 
right. There it still can be sorted.
Alternatively a measurement in the measurement 
window can be overlaid temporarly by a right 
mouse click (S. chapter 4).
The unification can take place via overlaying 
(merging) or adding (appending).

Append

Attaching makes sense in order to represent 
different processes one behind the other in a row. 
Select a measurement with all test zones or 
individual test zone selected and click the button 
„Append“.
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Menu Data

Selection window for the example append:

Assign a name.
This selection leads to the following result of 
analysis: 
 
 
 
 
 

 
 
 
 
 
The selected measurements are represented one 
after the other. 
At the temperature analysis, the individual mea-
surements are combined into a zone. Designation 
and analysis take place on basis of first measure-
ment. 
A new file is produced, which appears in the mea-
surement window. In the course of the unification 
you can assign another name for the file and make 
further entries.
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Merge (overlay)
 
Merging makes sense in order to compare the 
same measuring process of different data to 
examine process stability.
Selection Window for the example (merge)

 
 
 
 
 
 
 
 
 
Select „Merge“ and assign a name.
This selection leads to the following result of 
analysis:

 
 
 
 
 
 
 
 
 
 
The measurements are represented merged into 
each other in the diagram. In the temperature 
anlaysis of both zones appear particularly. The 
analysis is accomplished on the basis of the tem-
perature defaults of the measurement which was 
selected first.

Menu Data
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A new file is produced, which appears in the 
measurement window. In the course of the 
unification you can assign another name for the file 
and make further entries.

1.1.2		  Edit

Comment

If you click the button „comment “, the window „Edit 
measurement comment “ opens. 
Here, in general, additional information is entered, 
which stands in connection with the measuring 
process. 
However, they appear only in the printing area 
information. 

Remarks

By clicking the button „Remarks“, a selection 
window for a note opens within the diagram. First a 
color must be selected, afterwards the text can be 
entered.

The notes are freely adjustable in the diagram.

A further possibility is to open with a right mouse 
click a window directly in the diagram for the input 
of a note.

Menu Data
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1.1.3	 Section QC Procedures
The section QC Procedures contains the following 
commands:
Save as QC 	 Allows to save the current settings 
Procedure	 (Oven, Tolerance curve, Curing 		
		  Conditions and Organizer) as a		
		  named QC Procure. Please also		
		  refer to the chapter How to Work	
		  with QC Procedures  as it contains	
		  useful advice for an easy operation 	
		  of the program.
Apply QC 	 Apply a different QC 			 
Procedure	 Procedure to the currently 		
		  open measurement.

1.1.4	 Section Oven/Zones
The section Oven/Zones allows to select a single 
oven zone and contains the following commands: 
Set Oven	 Allows to adjust the position of the 	
		  oven start (with a time value of 		
		  0[s]). 
Save Zoom	 Allows to save the currently visible 	
		  data into a new measurement
You can select zones, by opening the field with the 
zones (1), or with the buttons in the header (2).

1.2	 Menu View 

Menu View

1

2 2
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1.2.1	 Section Toolbars
The section Toolbars contains the following 
commands:
Sensors	 Hides or unhides the sensor 		
		  selection pane
Database	 Hides or unhides the left database 	
		  pane

1.2.2	 Section Grids
The section Grids controls the grids resolution:
Off		  Check to suppress grids
Major		  Check to draw major grids only
Minor		 Check to draw major and minor 		
		  grids

1.2.3	 Section Vertical
The section Vertical Grids controls the settings for 
vertical grids: 
None		  Check to suppress vertical grids
Time		  Check to draw grids for the time 	
		  axis
Distance	 Check to draw grids for the distance 	
		  axis
Zones		 Check to additionally draw zone 	
		  margins

1.2.4	 Section Horizontal
The section Horizontal Grids controls the settings 
for horizontal grids:
None		  Check to suppress horizontal grids
Temperature	 Check to draw grids for the 		
		  temperature axis
Min		  Check to mark the Min-value of the 	
		  curing conditions
Max		  Check to mark the Max-value of the 	
		  curing conditions
Low		  Check to mark the Low-value of the 	
		  curing conditions
 	

Menu View
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Menu Instrument

Mid		  Check to mark the Mid-value of the
		  curing conditions
High		  Check to mark the High-value of the 	
		  curing conditions
Threshold 	 Check to mark the Threshold-Value 	
		  of the curing conditions
Zone		  Check to mark the Temperature 		
		  Range of the oven zones

1.2.5	 Section Axes
The section Axes allows to edit the properties of 
the various axes: 
Edit	 	 Edit Axes definitions
Styles		 Edit Line Types definition

1.3	 Menu Instrument

1.3.1	 Section Connection
The section Connection of this tab can be used to 
select the type of instrument and or interface:

temp-gard 	 To use a temp gard 8p, which is attached 	
8p		  to the serial Interface of your PC. The 	
		  SRAM card must be inserted 		
		  in the Logger. The old temp-gard is not 	
		  recognized automatically. Select the 		
		  COM port from the list right. If the PC 	
		  does not have a serial connection, an 	
		  Adapter is needed (USB to serial port).
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Menu Instrument

temp-gard	 Check to use a  temp-gard 6p or a  
6p/12p	 temp-gard 12p that is connected to 	
		  the USB port of your PC. The new 	
		  Logger (temp gard 6p/12p) is reco-	
		  gnized and the Serial Number is 	
		  indicated automatically.

SRAM/USB	 Check to use an USB-Stick (temp-
Stick		  gard  6p or temp-gard 12p) or a 		
		  SRAM card from a temp-gard 8p

1.3.2	 Section temp-gard
The  section temp-gard contains the operation 
commands for the selected instrument:

Transfer Data		 Use this command to 		
			   import a measurement from 	
			   the selected device.
Send Organizer	 Use this command to pre	
			   pare the selected device for 	
			   a new measurement
Delete Data on 	 Use this command to delete 	
SRAM/USB Stick	 data files from an USB 	 	
			   Stick or a SRAM card

1.3.3	 Section gradient-oven
The section gradient-oven contains the operation 
command for a BYK gradient oven: 
 
gradient-oven		 Sends temperature curves 	
			   to the gradient-oven and 	
	 	 	 controls the data flow of the 	
			   instrument

Attach the gradient-oven and select from its Main 
Menue: 
•	 Point 3 byko-track or 
•	 Point 4 byko-track 2. 
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Menu Options

In the Software temp chart: 
•	 load the measurement curve 
•	 select gradient-oven in the Instrument tab 
•	 select probes

1.4	 Menu Options 

The Options Tab contains the settings that control 
the display of various values:
Temperature	 Please choose between 		
		  °Celsius, °Fahrenheit and Kelvin.
Duration	 Please select the appropriate 		
		  setting for duration values.
Length	 Please select the appropriate 		
		  setting for distance values.
Gradient	 Please select the appropriate 		
		  setting for temperature gradients  
Speed		 Please select the appropriate 		
		  setting for speed values.
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1.5	 Menu Print 

1.5.1	 Section Options
The section Options contains   commands to 
preselect various settings:
Define Print Layout	 Controls the content of the 	
			   printed pages (more details 	
	 	 	 find on p. 40).
Select printer		 Show the windows dialog to 	
			   select a different printer

1.5.2	 Section Print
The section Print contains the following 
commands:
Print			   Select Printer and Print the 	
			   current pages
Quick Print		  Print using the current 		
			   settings
Preview		  Preview the current pages 	
			   before printing
PDF			   Output as PDF file

Menu Print
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1.6	 Menu Quick Access Toolbar 

The commands “New database“, “Open database“ 
and “Quick print“ are already preselected to be 
displayed.
If you click on one of these items with the left 
mouse button, the checkmark disappears and the 
command is not displayed in the Quick Access 
Toolbar any more.
To redisplay it, click on the item again with the left 
mouse button.
To add more commands to the Quick Access 
Toolbar click on “More Commands“. The  
Customize window opens:

Menu Quick Access Toolbar
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You can now add or remove commands.

Show Below the Ribbon
The Quick Access Toolbar is placed below the 
ribbon with the opened tabs.

Minimize the Ribbon
If you minimize the ribbon only the menu tabs are 
shown. To access a function you have to click on 
the appropriate menue tab. The ribbon for this 
menu tab will be redisplayed again.
Consider whether it is worth to minimize the ribbon 
because that can draw a handicap in operation.

Menu Quick Access Toolbar
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Measurement control with the organizer

Then
1. Enter the General information like customer 
name, locations, comments

2	 Objects for control and analysis

2.1	 Measurement control with the organizer 

Step 1:
The temp-chart software allows creating so-called 
organizers which define the „Setup parameters“ 
and names of the probe position. If you have not 
already done so, please • Select Objects in the left 
side database pane

•	 Right click Organizers and Create a new 	
organizer

•	 Name the organizer by pressing the „Save 
As“ button (the name may have at most 8 
characters)
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Set Curing Conditions

2. Enter the probe names and select the color for 
display
3. Enter the sampling rate, trigger information and 
measurement duration
4. Load a picture (most graphic formats like bmp, 
gif, jpeg are supported) and position the sensors 
by dragging the numbered squares from the upper 
left corner of the picture 
Step 2:
Connect the temp-gard to the PC or insert the 
USB-Stick. Then activate the Instrument tab, make 
sure you have selected the appropriate connection 
settings and press

Select the newly created organizer in the upcoming 
dialog and press OK.
The Organizer will now be transferred to the USB 
stick or the connected device and can be used 
for new measurements. Already existing QC-
procedures can likewise be selected and assigned.

2.2	 Set Curing Conditions 

The paint makers recommend temperature/
time conditions will be compared to the actual 
temperature/time during the heating process.
temp-chart allows you to define and modify 
objects of type „Curing Condition“ where you 
can enter the supplied target values. These 
values are then used in the analysis pane and in 
the  protocols temperature defaults, Cure index 
and Peak/Threshold/Slope. On the basis of the 
equivalence time the Cure index is computed.
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This page contains the critical values and duration 
times required for controlling the hardening 
process. In most cases, these values are furnished 
by the supplier of the material.
Fill in the respective limiting value in the 
Temperature column, and the required duration 
time in the Time column: 

Min		  the minimum temperature 
		  that should be reached 
Low		  lower limit			   duration time of the 		
						      lower temperature limit
Mid/Ref	 mean or reference		  duration time of the 		
		  temperature			   reference temperature	  
High		  upper limit			   duration time of the upper 	
						      temperature limit
Max		  the maximum temperature
		  that should not be exceeded 
Threshold	 limiting value for the calculation  
		  of the threshold analysis
A.Energy	 Activation Energy

Set Curing Conditions
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Set Curing Conditions

The activation energy is calculated automatically 
on basis of the retention times at the lower 
and upper temperature. It is the basis for the 
calculation of the equivalence time.
For calculating the Equivalent Holding Time, you 
can either enter the activation energy of the material 
directly, or you can have the program do the 
calculation for you:
For this purpose, enter the required temperature 
as well as the duration time into the Low and High 
boxes as the program needs two reference values 
for calculating the activation energy. Next, look at 
the tables and compare the calculated equivalent 
time with the required duration time of the reference 
temperature. This will give you a measure for the 
quality of the hardening process.
With the option box „Calculate Above Minimum“ you 
can exclude temperature values below the minimum 
temperature from the calculation of the equivalent 
time.
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Set Oven Specifications

2.3	 Set Oven Specifiations 

Defining some parameters for the oven used 
during heating is optional, but has some 
advantages during analysis
• 	 With the given speed of the oven, the software 

can add a distance axis in addition or instead of 
the time axis

• 	 you can partition the heating process into 
zones which can be analyzed separately

You should create an Oven Specification once. It 
can then be assigned to different measurements 
or added to the QC-Procedure:.
•  	 Select Objects/Oven Specifications in the 

database pane
•  	 Right click and Create a new object
•  	 Name the object with a suitable description and 

press the „Save As“ button
•  	 Enter the oven specifications
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Set Oven Specifications

•  The Oven Name can be freely chosen
•  Enter the speed of your oven in the Speed box. 
If you fill in nothing or 0 m/s, the program will be 
unable to show a distance axis.
•  In the OvenStart box, please enter the time 
your oven needs to reach the first „real“ zone. All 
data values recorded before this point of time will 
then appear on the time axis with a negative sign. 
(Note: This offset can also be changed afterwards 
by switching to the chart page and moving the 
zero zone on the zone axis. Or, you can press the 
right mouse button in the area of the temperature 
curves and select the command Oven Offset in the 
opening context menu.)
•  To divide your measurement into Zones, please 
additional lines to the zone list. Then, in the table, 
enter the zone length as Duration. The zone tables 
normally only show the times, but if you have 
entered a speed there, you can also enter the 
position and length in meters.
If you want to delete a zone right click in the 
number-column and select the desired command.
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2.4	 Set Tolerance Curve 

A Tolerance Curve is a collection of reference 
values the program will take as a basis for creating 
the tolerance curve shown in the chart page 
facilitating the evaluation of measurements.
You should create a Tolerance Curve once. It can 
then be assigned to different measurements or 
added to the QC-Procedure:
•	 Select Objects/Oven Specifications in the 

Select Tolerance Curves database pane
•	 Right click and Create a new object
•	 Name the object with a suitable description and 

press the „Save As“ button
•	 Enter the tolerance settings

• 	 The Name of the Tolerance Curve can be freely 
chosen.

• 	 The Frame Color and Background choices 
determine the colors used in the chart page. 
Please select None in the Background field if 
you want to show only the outline.

Set Tolerance Curve
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Set Tolerance Curve

•	 By selecting None in the Smoothing option 
box you can linearly link the defined reference 
values. When you choose the options Yes or 
More, however, help values will be created to 
obtain as round a curve as possible.

There are two ways of creating reference values:
• 	  Add additional lines to the list of reference 

values; enter the position (At) and both limiting 
values (Lower and Upper) in the table. Then, 
the reference values will be shown in the chart.

•  	 Move the cursor into the chart and drag it from 
the upper to the lower limiting value while 
pressing the mouse button. When releasing the 
button, the program will insert a new reference 
value.

In the chart, the reference values are indicated as 
small circles; these circles can be moved with the 
mouse in order to move the reference value.
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Create a Cure Chart

2.5	 Create a Cure Chart
Cure chart is a diagram of the duration time at 
certain temperatures. So it is to be seen at a 
glance whether the curing process lies within the 
defaults of the paint manufacturer.
In the edit pane of the cure chart settings a curing 
window is created according to the defaults of the 
paint manufacturer. It can contain different ranges, 
e.g. good, still OK, overcured.
The data is entered in a table and can also be 
edited in the diagram window.
Right click on cure-chart from the Objects pane. 
The selection windows opens. Select “Create“ to 
create a new cure-chart.
The cure-chart window opens. Here you can enter 
coordinates (time, temperature), annotations, 
target points and analysis points or ranges.
Give the object a definite name and specify the 
temperatures for the analysis. The pre-setting is 
at 120 - 160 °C and must be adapted according to 
the measuring range if necessary.

Afterwards you must select a color for the range.
With a left mouse click into an empty color field you 
open the selection. select the color and confirm it 
with another left mouse click.
To edit the area, right click into the correspondent 
row and then left click onto the “Edit“-button.
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Create a Cure Chart

The Edit Cure Chart Area appears.

The area can be changed either by entering data 
directly into the “Time“ and “Temp“ fields or by 
picking the corners of the diagram, in order to 
move it where you need to.
To add delimitation points move the cursor over the 
diagram and make a left mouse click. You can also 
make a right mouse click into the table.
You can terminate your input by pressing the “OK“ 
button. The Cure Chart setting pane appears with 
the assigned cure window.
It is possible to add additonal areas by following 
the same procedure. Right mouse click into the 
cure window chart for setting the axes.
To complete the cure chart you can add 
Annotations and Target Points. If all inputs are 
terminated, finish with store.
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Pass/Fail function in Cure chart 

 
You can adjust a Pass/Fail warning in the Cure 
chart for each sensor by 
 
•	 Creating a Cure chart 
 
•	 selecting the color for the Cure chart 
 
•	 calling the editing function of the Cure chart 	
	 range with a right mouse click into the 		
	 coordinate line 
 
•	 selecting the function “Fail if “for the desired 	
	 sensor

Create a Cure Chart
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2.6 Set Pass/Fail
The Pass/Fail conditions can be set in the Pass/
Fail Tab.

Therefore you can select temperature-values and 
all conditions of the Cure index as criterions and 
can cover them with values.
Exceeding or falling short of the corresponding 
value, is shown in red color in the analysis table.
In the Tab Pass/Fail events, sensor, criterion and 
reason are shown.
In the data base list, the measurement is marked 
according to Pass/Fail result with a red or green 
point.

Set Pass Fail
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2.7	 Work with QC Procedures

temp-chart-QC-Procedures are the best solution 
for recurring tasks:
Most measurements are serial measurements 
which have to be carried out more than once, 
and it is often difficult to keep the measurement 
setup, i.e. the sampling interval or the number 
of sensors, identical or at least comparable. The 
matter becomes even more difficult when new 
parameters, such as the product type and oven 
speed, the tolerance and critical values have to be 
defined anew for each measurement. For these 
tasks, temp-chart-QC-Procedures are the ideal 
solution because they represent „measurements“ 
which - as yet - have no data values but which 
already contain some or even all the parameters.
Anyway, in the QC-procedure the complete 
measurement setup is saved, and in addition you 
can enter and save all the additional information in 
the organizer, such as comments, critical values, 
tolerance and reference curves, oven setups etc., 
that are already known before the measurement. 
This ensures that measurements prepared with the 
same procedure are really comparable.

Work with QC Procedures
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QC Procedures can be assigned in three places

•	 Together with the organizer during the 
preparation of the measurement, this leads directly 
to an automatic analysis of the measuring data 
according to the assigned objects after the import 
of the measurement:

Work with QC Procedures
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•	 When importing the measuring data into 
the database first the QC-Procedur and then the 
desired measuring file is to be select, then directly 
the analysis of the measuring data takes place 
after the import.

•	 In the menu data with the function „Apply 
QC Procedur“. This way, a QC Procedur can be 
assigned to an already imported measurement. 
So it is also possible to evaluate the results of 
measurements with a new analysis (e.g. changed 
curing conditions or another Cure chart)

Work with QC Procedures
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Prepare a Measurement

3	 Handling and Preparation

3.1	 Prepare a Measurement

Connect the temp-gard to the PC or insert the 
USB-Stick. Then activate the Instrument tab, make 
sure you have selected the appropriate connection 
settings and press

Select an organizer in the upcoming dialog and 
press OK.
The Organizer will now be transferred to the USB 
stick or the connected device and can be used 
for new measurements. Already existing QC-
procedures can be selected and linked likewise.

3.2	 Read Measurement Data 

Step 1:
Measurements can be imported from the 
instrument either directly (connected via USB or 
the serial Port) or via a transport medium (an USB-
stick in case of a temp-gard 6p or temp-gard-12p, 
or a SRAM card in case of temp-gard 8p). The 
procedure is almost the same in all cases.
For a temp-gard 12p for example:
•	 Switch the temp-gard logger on
•	 Connect the USB Stick to the temp-gard logger
•	 Data will be transferred to the stick automati-

cally. If there are Organizers on the stick, the 
Selection Menu „Configuration Files“ appears 
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and a selection must be made.  With “NO Confi-
guration” the Organizer which is already loaded 
remains in the Instrument and the Data are sent 
to the stick. If another Organizer is loaded, the 
Data in the instrument are deleted after trans-
ferring to the USB.Stick.

•	 Remove the stick from the logger and connect it 
to your PC

•	 In the temp-chart software
•	 Select the tab, fill in the connection choices and 

press

Step 2:
There may be more than one measurement file on 
the stick. Please select the appropriate file(s) and 
then fill in the organizer information:

Note that this information is already filled in if the 
device was prepared with temp-chart and the 
used organizer does still exist.
As soon as you press Close the selected 
measurement(s) is/are imported and opened in the 
software.

Read Measurement Data
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Read Measurement Data

These windows contain only the control information 
if the instrument was not prepared with an 
organizer. 
As soon as you press close, the selected 
measurement is imported and opened inside the 
software.
This data is already registered, if the instrument 
was prepared with temp chart and the used 
organizers still exists. 
As soon as you press close, the selected 
measurement is imported and opened inside the 
software. 
If the measurement was taken with a QC 
procedure, an automatic analysis takes place. 
Otherwise, the QC procedure can be selected with 
the data transfer.
Step 3:
It may be necessary to adjust the oven start 
position. In this case
•	 Go to the Data menu
•	 Execute function Set Oven Start
•	 A vertical line will appear which can be fixed on 

the real start point
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4	 Display and Analysis

4.1	 The Display

The temp-chart- screen is made up of the 
following elements (from top to bottom):
•	 the Caption Bar showing the name of the 

program as well as the name of the active 
database and the active measurement

•	 the Menu for selecting and executing 
commands,

•	 the Database pane with the stored 
measurements and objects,

•	 the Display Area which is divided into several 
pages accessible via the object tabs,

•	 the Status Bar that shows sensor values and 
coordinates. 

	 The  Display Area is made up like a notebook. 
You can open the page of your choice by 
clicking on the Object tabs at the lower margin 
of the area: 

Menu tabs

Analyze tabs

Object tabs

Table range

Analysis range

Data pane

The Display
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The Measurement page is again split into two 
areas (which may be resized by dragging the 
divider line): 

•	 the Chart pane  with the temperature curves, 
and

•	 the Analysis pane  with selected analysis results 

The other pages allow for inspection/assignment/
changes of various helper objects: 

•	 Cure Chart
•	 the Tolerance Curve
•	 the Oven settings
•	 the Curing Condition
•	 Pass/Fail
•	 the Organizer, and
•	 the QC-Procedure

With the right mouse button in the measurements 
window you can open and delete measurements 
and in addition you can temporarly overlay them.

The Display
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The Display

With the right mouse button in the Objects window 
you can open, delete or create objects. 
 
 
 
 
 
 
 

 
The Tabs below the analysis range fulfill the same 
function. By clicking on the Tab you get to its 
functions.

By clicking the Sensor Tab on the right hand 
side of the graphic you open the selection of the 
sensors. Here, you can switch them on or off by 
clicking them..
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4.2	 Analyze Measurement Data 

All measurements that have been acquired with 
this software were saved under a certain name. 
Directly after the import of the measuring data, 
the measuring curve will be indicated in the chart 
range, all analysis tables are closed and can be 
opened if necessary. They can be searched for 
and opened in the database pane at any later point 
of time. If a measurement is not already visible, 
please go to the database pane and double click 
the desired measurement.

4.2.1	 The Chart area

The following things are indicated: 
• the temperature curves of all sensors; individual 
curves can be indicated or hidden with the button 
in the sensor window. 
Pull the mouse over the curves, and the program 
shows the data values of the time and temperature 
axes at the lower edge of screen. 
If you would like to expand a certain section of the 
measurement you can either: 

Chart area
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• move the axes with the mouse or 
• draw a square over the section, which interests 
you, by keeping the mouse button pressed.
A following double click indicates the cutout (See 
section: Scale Axes). 
• the tolerance curve, which can be indicated or 
hidden with the button T in the sensor window.
With the scaling of the temperature and time axes 
preset by the program, the entire measurement is 
visible. However, you can also select a fixed scaling 
in the axis section of the View-menu in order to be 
able to easily compare various measurements. Here, 
you can also determine if and where distance and 
zone axes shall be drawn, whether or not a scaling 
grid is shown and which auxiliary lines are given.
You can also use this page to define zone-
independent measurement sections. Please also 
refer to the chapter: Scaling.
Immediately below the chart you will see the 
Analysis pane  (resize by dragging the divider line):

4.2.1.1	 Scale Axes 

The chart view normally shows the entire 
measurement. If you want to look at a particular 
detail or determine measurement sections 
for analyzing purposes (e.g. an ascending or 
descending branch for slope calculation) you have 
two options:

Chart Area
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4.2.1.2	 Zoom Square
Draw a square around the part of the graphic that 
you are interested in by moving the mouse over it 
while holding the mouse button pressed.
Releasing the mouse button will display the zoom 
square. You can change the position and size of 
the square by dragging the corners.
When the zoom square is showing the section as 
you want it you can activate it by double-clicking 
the mouse.
Before, you have to choose “Autorange“ in the 
menu View -> Axes -> Edit at the item Time from 
the Axes list.
Note: The shape of the cursor indicates whether 
you are only moving the square to a different 
position or changing its size.

4.2.1.3	 Moving the Axes
Move the cursor into the scaling legend of an axis 
(e.g. of the temperature axis in order to change 
the temperature section, or the time axis in order 
to change the time section) and „drag“ the axis in 
the desired direction by holding the mouse button 
pressed.
When you release the mouse button the axis will 
be displayed in the new scaling.
If you only want to move the axis, i.e. leave the 
expansion as it is, you must hold the shift key 
pressed while moving the mouse!
Note: The shape of the cursor indicates whether 
you are only moving the axis to a different position 
or changing the size of the section.

4.2.1.4	 Restoring the Original Scaling
In order to restore the original scaling you can
•	 Right click anywhere in the chart area and select 

the Rezoom command in the context menu.

Chart area
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4.2.2		 Analysis area

The analysis of the measurement is indicated in 
the analysis window. It takes place via application 
of the objects: Cure Chart, Tolerance Curve, Oven, 
Curing Conditions, Pass/Fail 
These objects are automatically assigned if you 
work with QC procedures (see section 2,7) If this is 
not the case, the assignment can be made by the 
Object Tabs. Here, objects already provided can be 
opened, or new one‘s be created.

4.2.2.1	 Critical values

The table of results consists of five columns:
Min		  indicates for how long the curve 		
		  was at the minimal threshold 		
		  value
Low		  indicates for how long the curve 		
		  was at the lower threshold 		
		  value
Mid		  indicates for how long the curve 		
		  was at the mean threshold 		
		  value

Data Values Analysis Results
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High		  indicates for how long the curve 		
		  was at the upper threshold 		
		  value
Max		  indicates for how long the curve 		
		  was at the maximum threshold 		
		  value
Cure Index	 which was computed on the basis 	
		  of the equivalent holding time
Note: The first two lines in the header show the 
set threshold values and duration times; to change 
them, please use the Curing conditions page.

4.2.2.2 Cure Index

The table Cure index permits a simple evaluation 
of the curing process. Here the Cure index - a 
measure for the quality of the hardening process 
- is computed. An optimal Cure index of 100% is 
reached, if the equivalence time for the respective 
sensors is calculated and indicated in the column 
Equ Time corresponds with the period passed at 
the reference temperature (middle temperature).
Similar to the results in the „Critical Values“ 
section, the „Equivalent Time“ index is calculated 
to indicate the quality of the heating process: 
The table of results consists of four columns:
Low		  indicates for how long the curve 		
		  was at the lower threshold value
Mid		  indicates for how long the curve 		
		  was at the mean threshold value
Upper		 indicates for how long the curve 		
		  was at the upper threshold value

Data Values Analysis Results
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Data Values Analysis Results

Equ Time	 indicates the corresponding 		
		  equivalent heating time 			
		  (see Equivalent Time)
Cure Index	 in the column Cure Index, the % is 	
		  computed using the middle 		
		  temperature time as the optimal 		
		  curing = 100%.  All values above 	
		  100% are marked as over-cured

4.2.2.3	 Peak/Threshold/Slope

The table of results consists of five columns:
Peak		  indicates the peak temperature
TimeToReach	indicating the time at which the 		
		  peak was reached
TimeBelow	 indicates for how long the curve 		
		  was below the threshold value
TimeAbove	 indicates for how long the curve 		
		  was above the threshold value
Slope		 for the temperature slope of the 		
		  current section
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4.2.2.4	 Statistics

The table of results consists of five columns:
Min		  indicates the minimum temperature
Max		  indicates the maximum temperature
Mean		  indicates the mean temperature
StdDev	 indicates the standard deviation of 	
		  the temperature values
PeakTime	 indicates the time up to the 		
		  maximum temperature value

4.3	 Print Protocol 

temp-chart offers a variety of protocol types, in 
general, the standard protocol is the one most 
commonly used for print-outs. It shows not only the 
comments and measurement descriptions but also 
the charts and selected analysis results.
•	 Open the desired measurement unless it is 

already loaded.
•	 Activate the chart page and ensure that the 

entire measurement (resp. the section that you 
want the protocol of) is visible.

•	 Activate the Print tab and open the dialog to 
Define Print Layout

Print Protocol
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•	 Choose the format „Standard“ and confirm with 
Print or Preview:

Print Protocol
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Copyright

5	 Copyright

© Copyright 2014 BYK-Gardner GmbH
All rights reserved

No portion of the software, documentation or other accompanying materials 
may be translated, modified, reproduced, copied or otherwise duplicated 
(with the exception of a backup copy), or distributed to a third party, without 
prior written authorization from BYK-Gardner GmbH. In any case, this re-
quires the prior written consent of BYK-Gardner.

BYK-Gardner GmbH offers no guarantee that the software will function wi-
thout error or that the functions incorporated therein can be executed in all 
applications and combinations selected by you.

No liability other than as provided by law is assumed for direct or indirect da-
mage sustained in association with the use of the instrument, the software or 
documentation.

BYK-Gardner GmbH reserves the right to update the software and written 
documentation without prior notice.
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